/AOYLOULKO KOTOALOKEUNC EVVOLOAOYLKWYV
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[MoAAQ kepaoLAL...

e OLailBovoeg oepvapiwyv £XoVV YEULOEL LUE TIKPOVCLACELS
YL TIG SLUVATOTNTEG KOL TX TTAEOVEKTT| LA TA TWV
AOYLO LKWV EVVOLOAOYLKWYV XOPTWV

e Elonynoelg yla T1g SIOAKTIKES EPAPUOYES OTNV TALTN, LEXPL
KoL oXESLA EpYATiag KUKAO@OPOUV 0TO IVTEPVET KoL 0T
OXETIKA oLVESPLA

* Apaye 0 EAANvaG paBNTG Ta £xeL 6L KaABOAoL otV TAéN
TOV;
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Cmap tools

A. ABavacomovrog
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[Latt CmapTools;

e Elvat EAevBepo Aoylouiko (tpolmoBetel dwpedv eyypapn)

e Elvat (LdAAoV) TO TIL0 YVWOTO KAl SLodeSOUEVO

e OLxd&pTEG UTTOPOUVV VA SLOUOLPAGTOVV HUETAEY TWV
EYYEYPAUEVWV XPNOTWV (LECW KOLVOXPT|OTWYV
Slakoulotwy). Xpnopo av eiocat AyyAog...

e 'Exel TOAAEG SuvatoTnTES (Y EVOWUATWUEVT SLUVATOTNTA
SMNULOVPYLAG TTAPOVCLACEWV)

e Eqpappuoyn Java (aveEaptnTo amo AEITOUPYLKO oVOTNULA)
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[Latt oxt CmapTools;

e Aev €xel SLaloONTIKO TTEPLBAAAOV Xp1ioNG (TO KOLTAG KL
Ydyveoal.)

e Aev S1eEvKOAVVEL TTOAV 000UG S1I8AOKOVV TTOLOLA LLLKPT|G
NALKLXG (Ywpl§ ETOLUO ELKOVISLA KATT)

e Ta eAAnvikd dev vrtootnpllovtal KaAd (181K OL TOVIOUEVOL
XOPAKTIPEG)

e [IpwTtdéTUTIO CVUOTNUA ATTOONKEVOTG APXELWV KoL
Slaxelplong moOpwv...

@ A. ABavacodmoviog




MepBaAlov epyaoiog

ZE“}& £3 Untitled 1
Flo Edt Foemat Coladorate Took Wirdow  =elp

Fis =dt Tock ‘Wndos Hap

3wy cmans ¢ E- | PO v &
Ginapsin all 9 Cinan List Vi =]
oy Comenine i e
| Concepks | Linking Fhreses | Pronosiions | Cmap Cutdne
9 Type = new propeabiznand peess Enveri
Shared Cmaps “ “
" Plaoss | Conespr Lintivg Phrase Concept
A )
Fasrt=s | TOMOL pE opyeiol s
& CmapTools
o Y10L AVOLYLLOL ﬁ F
Diﬁtl’BO'ﬂY ﬂ Dtels publeclichlo crends a cancest 3
" Koppot ko
GVVOEGLLOL
2
(Xapog epyaociog)
R ———— Authd KMK Yo
=z = | mE= onovpyia
B thbamsticn: Chaamcter S ] véou KOuPov
i‘ﬂ' Dbjact | Line | Cmap v‘}
< |

Epyaieio emAoydv epedviong
TOL YGPTN EVVOLDV

Ay ((\LU-H-/\IJAJMI\-MU V V




=ekivnua (1°¢ tpormoc)

e Me SLTTAO KALK 0TO KEVTPO TNG AEUKNG TLEPLOYTG
(xwpov epyaciag), omOTe YPAPOULUE KATELOELOY
oTOV KOUo

Eumnnnl-ﬁﬂ]‘m click and drag arrow to make a link
double-zlick to edit text
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=eKkivnua (20¢ tpomoc)

* SUUTTANPWVOVTOG TO
Tplot KEALX OTO
moapdBvpo «Cmap List
View» (B€Aog) kot
matwvtas Enter

° v TO TP Bupo
«Cmap List View» dev
paiveTal, To
EVEPYOTIOLOVE OTIO
TO €lkoviotlo (1)

° A. ABavacodmoviog
. /




Neoc kAadoc amneuBeloc oto Ywpo
oxedlaopou

e YUPOVTAG KAl oiPVOVTAG TO SITTAO BEAOG
TIAV®W OTTO TO UNTPLKO KOuPo

[ Untitled 1 =13

File Edit Format Collsborate Tools  Window  Help

% | H- | Plo v &
e Crap List Yiew =

| Concepts | Linking Phrases| Propasitions | Crmap Outline |

Type a new proposition and press Enter:

Biomowihdn e | ” ” |

Concept Linking Phrase Concept
Bionoikiha T nzphapPavel m YEVETIT NOIKIAGTTTD
BionoikihoTmTa nepihapPiaval m CIKORDYIET) MOIIA,
CIKOROYIET MONIA, . 777 Y

aepiapfaver o)

-
|

ouokoyikl] TowhOT TN

—7 I

yevenikl] ok OTTo

)

Faads

| €

° A. ABavacomovAog
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AmobOnkevon

[€] views - Cm apTools |Z| |E| rz|

File Edit Tools Window Help
[
g My Crnaps
—_— ~fly amuna _organismaou
Cmaps in !Ti Biodiversi by
My Computer
Shared Cmaps
in Places
Lo
Favorites
History
[Jicons on Iy filll Delete

e ATO 1O pevov File Tov
Tapabupov epyaciog (OxL TOU

Views!) ETLAEYOULE Save Cmap.

e Ta amoBnkevueva apyeia
epavidovtal 6to Tapabupo
Views

@ A. ABavacodmoviog

fA Save Cmap As

Lacation:

Marne:

Focus Queskion:

feywords:

Language:

Authonz):

Organization:

Email:

| My Cmaps hd ‘

where will this zoncept map be located?

| Bindiversity

the name shown in the wisws

| what is Bidiversity?

what question does this concept map answer?

separated by commas

|Greek (Greece)

the language of the Cmap

| PAndreas Ahanasopoulos

[ Save H Cancel ]




Xpnon tou Style palette

e Av bev
BAETOVE TO
TP aBupo Styles
(1), ToTE: pevov
Window > Show
style palette

@ A. ABavacodmoviog

P il R Cobbeede Tous [RAekm ko
e | sL\i’ o3 70
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* ATO TNV KapTeAa Font
ULTTOPOVE VX
e AAAaEoupe
ypauuarocapoc (eldog -
LEYeB0G) evog KOIJ.BOU
. A)\AogEou LLE TO XP WL TOV
KELLEVOU
* AAAdgoupe Tn oToixLOM
TOU KEWWEVOU HECH GTOV
KOuBo
e Ta napomavoo LOYVOLV
Y 000UC Ko,uﬁovg
EYovue eMIAEEEL

@ A. ABavacodmoviog

Styles 1: oTUuA YPOAUUOTOOELPOLC

—Mame & Size

—Style & Caolor

|T

[Mews Stylel




Styles 2: AAN\oayn otul kOppou

* ATO TNV KapTEAQ
Object pmopov HE Va
o AAAGEOVLLE TO (POVTO
EVOG KOUPBov

e aAAdEouue oxnua,
XPWUO KL OKLX TOV
KoupBov (B}\sns oxnua)

o ATAwooOUpE 1)
CUPPLKVWOOVE TO

XaPTT]
* XTOL loovue TOVG
KOUBoug Tov xdptn
* Ta Tapamavw
LoXVOLV YIX 0G0UG
Koupovg éxovue
EMIAEEEL

@ A. ABavacodmoviog

it Collaborate  Tools  Window  Help

N T v Styles X]

—Color— —Background Image

m- DR
—Shadow . E m: ﬁ
Backaround Color————
= . AT
B RO ==t Space Evenly
IET Fized Gapl:l
—Shape —
—Stretch——————————————
H
o~ D T @ S
| F-:nnt|§|:||;.ject§| Line" I:rnapl
neprhapfiver
iy |I| |Unnamed | [New S‘q.rle]

/N

| YEVETIT) TOUAD alm.-.wmr] nnmlo'rr]m]

\

77




Ertthoyn kopBwv

e EmiAoyn evog:
Aplotepo kALK
ETIAV W TOV

e EmiAoyn moAAwv:
AploTtepo KALK +

Zupovtag (BA.
ElKOvVQ) : ;

o AmoemiAoyn| evag: o SIS
Control + KALK 0TO == e
OLVTLKELLEVO — il

e AmoeTmiA0YT] OAWV: =
KALK OTTOUONTIOTE = a3
OTO XAPTN
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MpooBnkn ewkovac o koppo (we povto)

 Drag-n-drop TNG £lkOVaG TTAVW 0TOV KOUPO (gppaviletal To Tapabupo
Edit resource link)

* Drag-n-drop NG €KOVAG pEoa 0To TapaBupo Views (IIpooAsg) ko
KAQTOTILY Styles > Object > Background image

e 'O,tLapyeio falovpue edw, pmopel peTa va eloayOel oTo XAPTN

° ANULOVPYDVTAG PAKEAOVG UELWVOVLE TO XAOG TWV resources 0TO
mapabupo Views

() set as Background
the image will be used as the background

|E| Views - CmapTools & Add as Resource link.

File Edit Tools Window Help Label: | panda0s |

Iabel shown under the concept

— I .

My Crnaps Group: | Inage v|

é Bﬁ icon shown under the concept
Cmaps in ,@ pandan4 Resource Mame: | pandand |

My Computer {Ty ursus rame shouy in the ‘dens winda

: H Resource Type: |@ GIF Image 3 |

@ Apkr) gEAifa ApTolpon

type of data this resource contains

sl MUNG_OhQanismaon

5h§lI’Ed Craps fTy Biodiversity dimensions 75 x 53
in Places -
Descri pkion:
qf'ﬁ shown as the caption under the image
. Keywards:
Favarites
separated by commas

Language: English v
the language of the resource
A AE History [] Don't capy this file to the views {create a shortcut)
: [ Ticons anly filll Delete




KL dAAQ KOATTOL

File Edit Format Collaborate Tools Window Help

e Me de&l kAl o€ ¢% | @ | Blo
KOUPO £XYOVE TIOAAEG
ETILAOYEG OTIWG TNV
ELoaywyn
VTIEPOVVOEDTG web

(XP1OLHO Qv
amoBnKeELOOVNE OE

Lop @ html)
* Aev pag apeoeL to
. > | € :
Conap > Backgound .
1image _‘ = Aplctt')pog

El
@ A. ABavacodmoviog
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vue

Visual Hnderstanding Environment

@ A. ABavacomovrog
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Visual Understanding Environment (Vue)

e AAAO EVO TTAVETLO TN ULAKN G TIPOEAEVONG AOYLOULKO
XOPTOYPAPTONG EVVOLWV
* XapaKTNPLOTIKA
e EAAnviko interface
* Yrtootnplén otpwoewv (layers), avtopatng
POV oo
e Avvatotnta cUUTTUENG / EKTTTLENG KAGS WV

e Epappuoyn Java (aveEaptnTo amo AELTOUPYLKO
oVoTN Q)

@ A. ABavacodmoviog



http://vue.tufts.edu/index.cfm

VUE: MarsRover-Map.vue

Apxeio Enetzpyacia MpoBoAri Moppn Mepiexopevo Aiadpopéc AvaAuon

X' O T | RO CHOHOHOHOHO

W [verap (479 |
k —
o=

[Epvasio avagimang (b) ]

1
J’- Prowes gt ) - Whipeia ll-"-.wm)

S M Exptoren Messrs

= NASA Prowes Meoen -
- -
= Prosee Waes Meoan - Horw

- -~
o
Al 4
s ~amaa
Mission
vt .
4
Sexse When Creme
— ~
,
Oads - Gkt Stw
=t Ogang deeper 110 U trerch uncovesd mons wis .
ot et

S0 OF MDY IV SUBCT ) Ful a1 ax

wov W Cortrm 1o mondor U fied g ste (AKA O
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mindomo
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XopaKTNPLOTLKA

* AlaSIKTLAKN £@aPLOYT) (0L XAPTES aToONKeVOVTAL OTO
[vtepveT) - amattel SwpPedv yypapn

e ‘000l YaPTES YopaKTNPLOTOUV "dNnuodciol” amd To SnuLovpyo
TOUG, elval eAeVBepa TPoTBACLLOL ATIO TOVUG EYYEYPAUUEVOUG
XPNOTES

* H dwpeav k00N ETITPETEL TEPLOPLOUEVO APLOUO LOLWTIKWV
EVVOLOAOYLKWV XOPTWV KL ATIEPLOPLOTO ApLlOUO SNUOCiwV

e OLydpTeG umopovLV va @TLaxTovv online, aAAd SiatiBeTal kat

wpaio Aoylouiko offline kataokeunc.Auto eival faclopévo oto
Adobe AIR omote tpéxel oe Windows kat Linux

e JUVTOUEVOELS TANKTPOAOYLOV OTTwG Tov Freemind pe tov
omoiov Ta apyela elval ovufato

@ A. ABavacodmovAog



http://www.mindomo.com/

™ Mindomo Desktop - & X

File Edit View Tools  Help [ Upgrade to PREMIUM! |
ﬁ (; o Tovpix: B F-:;nt j@jThelnesi Q:E Ql

Map Themes

@ B\ B B

-
-_J
Iy Theme »
| Ej Map Background »
A. A@OLVO(G()?IOD)\,OQ )

Pizpi x | [Qseaen | omine | Gp ) 0% 3£ ©——U O




Edraw mindmap
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E’. S ks E = Edraw Mind Map (Free Version) - Life Planner.edx Context Tools - gl X

File Home Insert Page Layout Libraries View Help Shape Format b I Get Business Version...,

S = hors
Libraries a P E—Q Life Planner.edx =

||] | |2|:| 0 40 ] |5|:| l5|:l| T a0 el |1|:I|:I |11|:| |12|:| |13U |14E| |15|J |1l5|:| 170
(TR ETTR NNRNN SRR NNTS IR NN SRR SYRA SNTA N (00 FNUT] NNT0S FTRt SNUTn ARnny ANunn FNvn Nvn ANATa SVnt SNy AUves Sy SUNys Fyvyy ANys Suvny SNvn Swnwy Sven ey Suvnn Sy Sunt i

(@)

A
1

10

Sub Topic

|I|:I|||I|||||-|

10

]|I|||||I|2:J||I|||||

0

iy
il

aau o Jodxg I!-y. saipadol @. digH aweult.q m;

1]

Main ldea

Main Toplc

[i{i]

T

|?::I||I||||||EP||I|||||

E Examples e Manager

W

| | 130 | 130 | 110 |1EIEI
b boooado oo

N - A < — 5
EENEESEEEEEEESEE 'EEEEE BE BE VEE FENEENE EEN |

Width = 1 eight = 85, Angle =0 | X = 53.3, Y=19.8 E= 100 &8 —9——— OF e

Main Topic 5, Shape ID = 679
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freemind
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XopaKTNPLOTLKA

* AoyLoMIKO eAeVBEPOL KWK

e ['PNYOPEC KATAOKEVEG YAPTWV EVVOLWV LE
OUVTOUEVCELG TIANKTPOAOY IOV

e Mmapeg epyaAelwy PeE ETOLUN ELKOVISLA - EVXPNOTO
ylo LKPOTEP X TTALSLA

e Ex800¢1g yia Linux kat Windows
* Yrtapxel apBpwpa (Module) yia Moodle

A. ABavacodmoviog




Hew Mindmap.mm* - FreeMind - Katdotacn evvolohoyikol xdptn ChiPortables\FreemindPortableBeta\Data\MindMaps\Hew Mindmap.mm

Apygio Encfgpyacio MpoPodl Bwoaywyn Mopgr Mhofynon Epyahsia Xapreg Berfaa
G O = T [150% MOmEd e « D Qi b2 B

o] MNew Mindmap.mm*l

@ o -Gia=|53n55eﬁf

—
Ve
Ilr

(Wese

| ~ |
\N?w Mind m_?E./; abc

EnzEzpyooia  Mopponoinon Mivakag  BorBaa

oo M B M Abadi MT Condensed Light 8 b i U 'Ig& == ==

<head>

OO L 4 am@POLUIOCOROX<Q00F —-vo &

</headX A QovacOmou oG

B3I

poohv) BIGTAEG | Mpofohv; ki HTML |




ConceptDraw MindMap

Eumopiké mtpoiov ($200)
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UM 3 &[4 5 WebSite Launch* - Concept...

Layout | View

lnput Qutput

o B R

x V| @~

Page—l (1/2)

Lv.j | & | ez iy uin&i o
R {4 Zoom Box 2P
Start Fullscreen ..., Previous Next | .. Create Refresh Create Default Panels and
Presentation i%]  Page Page & " Hand Scroll View > Previews Presentation < " Windows ~
Document View Navigation View Navigation Levels
- a) Topic Type g x
~ r Area:
[ WGb Site Lﬂtll'lCh }:’) & Storyboard sll Web pages :
2 | [project Management -
\ \, Wite 3 rough outline of 2ach pags's e = -
. J ()| Topic Type:
‘ e : Decide which graphics should appead Proiect Idea
| \’ which pages . J )
Create a i )| ¥ Requirements Document
= Sbeybosrd sad e, Lo Get parmission to use any copyrighted = Specification Document
‘ &/ detaled phn A\ \\, material =,
| A\ o & Human Resource
(W Create s master list of all ﬁl’e‘s S Material Resource
& ... Project
View Navigator = Project Group
(>) (O] X (I) Task
(“a-w. :l 3 Ve ™M Milestone
e -_
‘ e \ . ’:_: | Phase
[ viso stotasnen | L i aA | == e ¥ Show Data
View-4 View-3 View-2
Modified | Ready | 3 10] 85% & O () )
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AN\ (Owpeav)

¢ Xmind

® http://www.xmind.net/

* Awpedv €kd00o1 BACIKNG AELTOVPYIKOTNTAG
® Mind Meister
® http://www.mindmeister.com/
® Bubbl.us
® https://bubbl.us/
° Awpeav (amaltel eyypaen) SLadIKTuako Tpoypapua

@ A. ABavacodmoviog



http://www.xmind.net/
http://www.mindmeister.com/
https://bubbl.us/

AA\a (epmtoplka)

® Inspiration
e Eumopiko mpoiov
* Ytapyxouvv SLA@opeS TOUPUAAAYES OTIWG YIA TIALOLA

(kidspiration) Stadiktvaxr) e@apupoyn (Webspiration)
KATT

® Mindjet

° http: / /www.mindjet.com/

e A6 15%/unva
e ALadIKTLAKO
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http://www.mindjet.com/
http://www.mindjet.com/
http://www.mindjet.com/

